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Introduction

Whenever you use the Web, you are using hyperlinks to navigate from one
— - web page to another. If you want to include a web address or email address
[ x PL - = . . N .
._JJ | J 4| inyour PowerPoint presentation, you can choose to format them as hyperlinks
Hyperink Action  Text Header wi|  thataperson can click on. It's also possible to link to files and other slides
[j? Box & Footer within a presentation. It's easy to do all this using two tools: hyperlinks and
L — action buttons.

nimations Slide Show Review

Insert Hyperlink (Ctri+K)

Create a link to a Web page, a In this lesson, you will learn how to insert hyperlinks using text and objects,
e T UL as well as how to insert action buttons.

&) Press F1 for more help.
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Inserting Hyperlinks

Watch the video to learn how to insert hyperlinks.

lvantage of Free ( Onhne Learr
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Watch the video (3:14). Need help?

About Hyperlinks

Hyperlinks have two basic parts: the address of the web page, email address, or other location that they are
linking to, and the display text (or image). For example, the address could be http://blog.gcflearnfree.org,
and the display text could be "blog". In some cases, the display text might be the same as the address. When
you're creating a hyperlink in PowerPoint, you'll be able to choose both the address and the display text or
image.
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To Insert a Hyperlink:

1. Select the image or text you would like to make a hyperlink.
2. Right-click the selected text or image and click Hyperlink.
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Exit Edit Text
Font...

Paragraph...

Bullets |
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Convert to Smartart
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Hyperlink...

Synonyms

Tpun
3

Translate

Format Text Effects...

& &

Format Shape...

Creating a hyperlink

3. The Insert Hyperlink dialog box will open. You can also get to this dialog box from the Insert tab by
clicking Hyperlink.
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Insert Hyperlink @Iﬂ—hj
Link to: Text to display: |Free Online Computer Training ScreenTip...

Look in: Documents ] ‘(Q, =
Existing File or | — |ZI
Weh Page Bookmark...
I Current —
Folder
Place in This
Document Browsed
Pages
Create New Recent
Document Files
Address: htn:u:ffux'ww.gcﬁearnfree.nrg,.':[ E
E-mail Address
[ 0K ] [ Cancel

.

The Insert Hyperlink dialog box

If you selected text, the words will appear in the Text to display field at the top. You can change this text if

you want.
5. Type the address you would like to link to in the Address field.

6. Click OK. The text or image you selected will now be a hyperlink to the web address.

The completed hyperlink

To Insert a Hyperlink to an Email Address:

1. Right-click the selected text or image and click Hyperlink.
2. The Insert Hyperlink dialog box will open.
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3. Onthe left side of the dialog box, click Email Address.

=
Insert Hyperlink M
Link to: Text to display: | | ScreenTip...

E-mail address:
Existing File or | |
Web Page

Subject:

Place in This | Recently used e-mail addresses:
Document

Create New
Document

E-mail Address

ot || cancel

Creating an email hyperlink

4. Type the email address you want to connect to in the Email Address box and click OK.

Insert Hyperlink m

Link to: ;_I'extto display: |will@gcﬁearnﬁee.org | | ScreenTip... l
E-mail address:
EgﬁﬁEgPFile ar |mai|to:will@gcﬁearnﬁ'ee.nrg |
eb Page
“Subject:

Place in This | Recently used e-mail addresses:
Document

Create New
Document

E-mail Address

Cancel

Typing the email address and display text

PowerPoint often recognizes email and web addresses as you type and will format them as hyperlinks
automatically after you press the Enter key or spacebar.

To Open and Test a Hyperlink
1. After you create a hyperlink, you should test it. Right-click the hyperlink and click Open Hyperlink.
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Opening a hyperlink

2. Your web browser should open and navigate to the linked page. If it does not work, check the hyperlink

address for any misspellings.

To Remove a Hyperlink:

1. Right-click the hyperlink.
2. Click Remove Hyperlink.

©1998-2011 Goodwill Community Foundation, Inc. All rights reserved.



('Zj
.
"0
0
.

0 Free Online Compufis

=3 Copy

Microsoft Office clagg o

0 Ofﬂ|ne Resources: S Exit Edit Text
Font...

0 Financial and Retirer ikt
Numbering | »

Convert to Smartart  »

= TR e

Edit Hyperlink...
Open Hyperlink
Copy Hyperlink

s

Remove Hyperlink

Synonyms

Tain
3

Translate

Format Text Effects...

& &

Farmat Shape...

Removing a hyperlink

Page 3

More Hyperlinks

In PowerPoint, you can also use hyperlinks to link to resources that are not online. To create a quick way to refer
to another slide in your presentation, you can create a hyperlink to that slide. You can even create hyperlinks to
files stored on your computer.

To Insert a Hyperlink to Another Slide

1. Right click the selected text or image and click Hyperlink.
2. The Insert Hyperlink dialog box will open.
3. Onthe left side of the dialog box, click Place in this Document.

©1998-2011 Goodwill Community Foundation, Inc. All rights reserved.



@) GCF

di‘\ LearnFree.org

i ™
Insert Hyperlink m

Link to: Text to display: |About AdWorks

Select a place in this document: Slide preview:
Existing File or
Web Page
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Document

Slr—e

=l
Create New
Document

Show and return
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e

Creating a hyperlink to another slide

4. Alist of the other slides in your presentation will appear. Click the name of the slide you would like to link to.

-2 [

Edit Hyperlink -
Link to: Text to display: |About AdWorks

List of slides in the
same presentation

Select a place in this document:
Existing File or - First Slide
Web Page '
- Last Slide
. Next Slide About AdVWorks

- Previous Slide
Place in This [=-Slide Titles

Document -1, AdWorks Agency MNew Ei
- 2, Topics —!
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Create New
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- 0. QOrganization -
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——

Selecting a slide to link to

5. Click OK. The text or image will now be a hyperlink to the slide you selected.

©1998-2011 Goodwill Community Foundation, Inc. All rights reserved.



The completed hyperlink to a slide

To Insert a Hyperlink to Another File
1. Right click the selected text or image and click Hyperlink.
2. The Insert Hyperlink dialog box will open.
3. Onthe left side of the dialog box, click Existing File or Webpage.
2 e |

Insert Hyperlink

Link to: Text to display: |Complete Employee Benefit Manual

. ti'I Look in: ) AdWorks IEI
wisting File or
Web Page , Corporate Bookmark. ..

4% Current
Folder
Place in This
Document Browsed
Pages
Create MNew Recent
Document Files
Address: H:\adwarks |E|
E-mail Address
[ 0K ] [ Cancel

Creating a hyperlink to a file
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4. Click the drop-down arrow to browse for your file.

Insert Hyperlink M

Link to: Text to display: |The most recent copy of our monthly report | ScreenTip...
E—
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Browsing for a file

5. Select the desired file.

=
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Web Page | Accounts Bookmark. ..
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Document Files
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E-mail Address
i oK I Cancel
[ L]

Selecting a file

6. Click OK. The text or image will now be a hyperlink to the file you selected.
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0 Free Online Computer Training: Great website fo

Microsoft Office classes, Computer Basics, and
0 Offline Resources: See your manager
0 Financial and Retirement Planning

0 The Most Recent Copy of Our Finarlcial Report

The completed hyperlink to a file

i you plan on displaying your presentation on a different computer than you used to create it, your hyperlink to
another file may not work. Make sure you have a copy of the linked file on the computer you are using to
present and always test hyperlinks before giving a presentation.

Page 4
Inserting Action Buttons

Watch the video to learn how to insert action buttons.

Watch the video (3:14). Need help?

In addition to hyperlinks, another tool you can use to connect to a web page, file, email address, or slide is called

©1998-2011 Goodwill Community Foundation, Inc. All rights reserved.



an action button. Action buttons are built-in button shapes that you can add to a presentation and set to
link to another slide, play a sound, or perform some other action. When someone clicks or moves over the button,
the selected action will occur. Action buttons can do many of the same things as hyperlinks. Their easy-to-
understand style makes them especially useful for self-running presentations at booths and kiosks.

You can insert action buttons on one slide at a time, or you can insert an action button that will show up on every
slide. The second option can be useful if you want every slide to link back to a specific slide, like the title page or
table of contents.

To Insert an Action Button on One Slide:

1. Click the Insert tab.

2. Click the Shapes command in the lllustrations group. A drop-down menu will appear with the action
buttons located at the very bottom.
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Insert Design Transitions Animations Slide Show Re

2

2 o B3P g « £

Jlip  Screenshot Photo Shapes|Smartart Chart Hype Action T

&rt < Album = - E
Images Recently Used Shapes

BN NOO0OALLdG

CORTAN R 4

Lines

SNNSNTLTLL T G G

Rectangles

(] () [ ) [ [ ) ]

Basic Shapes
EOoAMIASGOO@W®
@GLO0ar Ly od
OO®AHOY A [ D™
()40 14 &

Block Arrows

DAL RLER IS
6 Qv [REdalf
Loa

Equation Shapes

=% ==

Flowchart
O0<0000F<=0dy
COON®D X ¢ AVED
QOO

Stars and Banners
el gstelototof ot 1o
R R () B [T R R |

Callouts

[ D6 €0 .0 A0 d0 AL A i A -
ri AD AD A0
Action Buttons

H%HEEEEEEEED

Action Button: Forward or Next

Selecting an action button

. Select the desired action button.

4. Insert the button onto the slide by clicking the desired location. The Action Settings dialog box will appear.

. Select the Mouse Click or Mouse Over tab. Selecting the Mouse Click tab means you action button will
perform its action only when clicked. Selecting the Mouse Over tab will make the action button perform its
action when you move the mouse over it.
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The Action Settings dialog box
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In the Action on click section, select Hyperlink to: then click the drop-down arrow and choose an option

from the menu.

=
Action Settings

[ [

Mouse Click | Mouse Over

Action on didk
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@ Hyperlink to: |

Last Slide

Last Slide Viewed
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Creating a hyperlink with an action button
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7. Check the Play Sound box if you want a sound to play when the action button is clicked. Select a sound
from the drop-down menu, or select Other sound to use a sound file on your computer.

-
Action Settings @u

lii—— e

Mouse Click | Mouse Qver

Action on dick
) None
@ Hyperlink to:

| First Slide E||

(7 Run program:

| | | Browse. .. |
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| -]
Object action:

| -]

[¥] play sound:
Mo Sound]
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Arrow
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Camera

Cash Register

Chime

Click

Coin

Selecting a sound

8. Click OK.
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The completed
action hutton

The completed action button

To Insert an Action Button on All Slides:

1. Click the View tab.
2. Inthe Master Views group, click on the Slide Master command. A blank slide in the style of your

presentation will appear. Don't worry about changing anything else.

Design Transitions Animations Slide Show Review View
- T | |
:I [ ruler ) Z A cilor %
|:| Gridlines _uh' E Grayscale
Slide Handout Motes ) Zoom  Fitto )
Master JMaster Master [C] Guides Window : Black and White
Master Views Show Fl Zoom Color/Grayscale

Changing the view to Slide Master

3. Gotothe Insert tab and follow the instructions above to insert an action button.
4. Return to the Slide Master tab and click Close Master View. The new action button will now be on every

slide.
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e (] Title A |
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Insert [#] Footers Edit  Background page
Layout Placeholder = Theme - -

Master Layout

Slide

Setup Orientation =

Page Setup

Close
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Close
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edit the slide show.
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To edit, move, or delete an action button inserted this way, click the View tab, then Slide Master. Click Close
Master View after making the desired changes.

To Test an Action Button:

After you create an action button, you should test it.

1. Click the Slide Show tab.
2. Inthe Start Slide Show group, click From Current Slide.

Insert Design

5

From

Beginning Current Slide

N

From Broadcast Custom

5lide Show Slide Show ~
Start Slide Show

Transitions

Set Up Hide
S5lide Show Slide

Animations

Timings

—--=
T &M

Rehearse Record Sl

KD

Show -
Set Up

Slide Show From Current Slide (Shift+F5)

Start the slide show from the current
slide,

Viewing the Slide Show

3. Click your action button.
4. After you have tested it, right-click anywhere on the screen and select End Show.
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Help
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Ending the Slide Show

5. If your action button did not work as you intended, follow the instructions below to edit it.

To Edit an Action Button:

1. Select the action button.
2. Click the Insert tab.
3. Inthe Links group, click the Action command. The Actions Settings dialog box will appear.

Add an action to the selected
object to specify what should
happen when you click on it or
hover over it with your mouse,

Design Transitions Animations Slide Show Review View Faorm
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B2 u e & = 4 Gk

Clip Screenshot Photo Shapes Smartart Chart | Hyperlink Action Text Header WordArt Dz

Art - Album ~ - Box & Footer - BT
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Action

Editing an action button

4. Edit the action or hyperlink.
5. Click OK.
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To Change the Appearance of an Action Button:

1. Select the action button.
2. Click the Drawing Tools Format tab.
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Changing the appearance of an action button

3. To change the button style or color, use the tools in the Shape Styles group.

Design Transitions Animations Slide Show Review \

| & shape Fill ~

Abe + | [ Shape Outline ~ A A

= | &} Shape Effects =
Shape Styles h‘ F] Wol

More

Choose a visual style for the shape
or line.

Changing the style of an action button
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4. To change the shape of the action button, click Edit Shape in the Insert Shapes group. Select a new

shape from the drop-down menu.
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Changing the shape of an action button

Page 5

Challenge!

1. Open an existing PowerPoint presentation. If you want, you can use this
example.

2. Select text and insert a hyperlink to a web page. If you are using the example,
go to slide 12. Turn the words "Financial and Retirement Planning” into a
hyperlink to http://www.mutualofamerica.com/.

3. Select text or an image and insert a hyperlink to another slide in the

presentation. If you are using the example, go to slide 2 and make the words
"Paperwork Process” link to slide 11.
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4. Insert an action button that uses sound. If you are using the example, go to slide
12 and create an action button that links back to slide 1.

5. Change the shape and style of an action button. If you are using the example,
modify the shape and style of the action button you inserted on slide 12.
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